
Salesforce Advanced Admin Exam Study Guide: Topic 6 - Content Management (7%) 

Salesforce Basics: For Advanced Admin Newbies 

If you’re stepping up to Advanced Admin or just hitting this stretch, no stress—here’s a 
giant, welcoming intro to get you excited, comfy, and ready to dive in. 

• What is Salesforce Advanced Admin?  

o It’s the top tier of Salesforce mastery—an online platform where you turn 
your org into a finely tuned powerhouse, mastering advanced security, data, 
changes, analytics, custom objects, and content management, all in the 
cloud with no tech nightmares needed. 

o Picture it as your business’s content curator—like a brilliant librarian who 
organizes files, shares knowledge, and keeps everything accessible, building 
on your basic Admin foundation. 

• Why It’s a Total Win:  

o It goes beyond basic records—like Accounts or Opportunities—and dives 
into managing files and content: storing docs, organizing libraries, and 
sharing with teams or customers. It’s like upgrading from a filing cabinet to a 
digital vault—your team gets info fast, secure, and smart. 

o As an Advanced Admin, you’re the content maestro—streamlining how files 
flow, like teaching a super-smart robot to manage your org’s documents with 
precision. 

• Key Words to Start With:  

o Org: Your company’s Salesforce world—like your team’s high-tech library 
where files live and content thrives. 

o Setup: The control hub (top-right gear icon) where you manage content—like 
the master console of your Salesforce content vault, giving you the tools to 
organize and share. 

o CRM: Customer Relationship Management—the core of Salesforce, now 
with advanced content tools to boost collaboration. 

• What This Topic Is All About:  

o “Content Management” is your deep dive into handling files and 
documents—using Salesforce Files, Content Libraries, and Content Delivery 



to store, organize, and share info. It’s like being the chief archivist of your org, 
making content a team superpower. 

 

Overview 

"Content Management" (7%) is a focused piece of the Advanced Admin exam—it’s about 
mastering Salesforce’s tools for files and documents, from uploading and organizing to 
securing and distributing them. You’ll go beyond basic attachments, tackling enterprise-
scale content needs. It’s 7% of the exam—a compact but critical slice—because efficient 
content management keeps teams aligned and customers informed. 

Exam Weight 

• Percentage: 7% 

• Why It Matters: Messy files slow teams—lost docs, unsecured access, or clunky 
sharing hurt productivity. With 7%, it’s a key skill for streamlining content in real-
world orgs. 

Objectives (In Super-Simple Terms) 

• Learn how to manage files—like uploading “Sales Guide”—so they’re easy to find. 

• Figure out how to organize content—like a “Marketing Library”—for teams to use. 

• Get comfy sharing content—like sending “Contract.pdf” to customers—securely. 

• Understand how to control access—like “Sales sees, Support doesn’t”—to keep it 
safe. 

 

Structure of the Study Guide 

• Definitions: Big, clear explanations of key terms. 

• Categories: Topics split into digestible chunks. 

• Bullet Points: Massive, beginner-friendly summaries with heaps of detail. 

• Tables: Side-by-side comparisons to keep it simple. 

• Practical Scenarios: Tons of real-world examples you can picture doing. 

• Study Tips: Step-by-step ways to nail this. 



 

Definitions (Huge Summaries with Tons of Beginner Details) 

• Salesforce Files:  

o What It Is: A system to store and share files—like “Proposal.docx”—across 
your org. 

o Details: Think of it as your org’s file cabinet—it replaces old-school 
attachments, letting you upload docs (e.g., PDFs, images) and link them to 
records (e.g., Opportunities). It’s cloud-based, searchable, and shareable—
like a modern Dropbox for Salesforce. 

• Content Library:  

o What It Is: A storage space—like “Sales Resources”—to organize files with 
permissions. 

o Details: This is your content vault—it groups files (e.g., “Brochures,” 
“Contracts”) and controls access (e.g., “Sales Team only”). Advanced 
Admins use it to categorize—like a library shelf for 1,000 docs. 

• Content Delivery:  

o What It Is: A way to share files—like “Price List.pdf”—outside Salesforce 
securely. 

o Details: Imagine it as your secure mail—it sends files to external users (e.g., 
customers) via a link with controls (e.g., expiration, password). It’s how you 
distribute content—like a digital courier with a lock. 

• File Sharing Settings:  

o What It Is: Rules—like “View Only”—to control who sees or edits files. 

o Details: This is your file lock—it sets permissions (e.g., “Owner edits, others 
view”) for Files and Libraries. It’s like handing out keys with limits—Advanced 
Admins tweak it for security. 

• Content Version:  

o What It Is: A new copy of a file—like “Proposal v2”—when updated. 



o Details: Think of it as your file history—each upload creates a version (e.g., 
“v1, v2”) so you track changes. It’s like a time machine for docs—keeps old 
ones safe while adding new. 

 

Categories 

• Content Tools: The big areas you’ll master.  

o Managing Salesforce Files 

o Setting Up Content Libraries 

o Using Content Delivery 

o Controlling Access and Versions 

 

Detailed Breakdown (Bullet Points with Massive Beginner Summaries) 

1. Content Tools 

• Managing Salesforce Files  

o Summary: Uploading, linking, and sharing files—like “Sales Deck.pptx”—
across records and teams. 

o Details:  

▪ This is your file hub—like a cloud drive in Salesforce. Files replace 
attachments, letting you upload docs, tie them to records (e.g., 
“Contract on Account”), and share with users or Chatter. Advanced 
Admins manage it—like handling 10,000 files for 500 reps. 

▪ How You Set It Up:  

▪ Upload: Record > Files Related List:  

▪ Details: “Upload Files”—like “Proposal.pdf.” 

▪ Link: Auto-ties to record—like “Opportunity #001.” 

▪ Share: “Share” button—like “Sales Team” or “Public 
Link.” 

▪ Chatter: Home > Chatter > “File”:  



▪ Details: Upload—like “Training.mp4”—post to group 
(e.g., “Support”). 

▪ Sync: Files > “Salesforce Files Sync” (if enabled):  

▪ Details: Desktop sync—like “Drag to folder.” 

▪ Why It’s Great: Flexible—like “One file, many records.” Searchable—
like “Find ‘Proposal’ fast.” Scales—like “1K files, no mess.” 

▪ What’s Tricky: Storage—check limits (e.g., 2GB/org + user 
allotments). Sharing sprawls—track it. Old attachments—migrate 
(Setup > Data > Legacy Attachments). 

▪ Real-Life Example: “Contract.pdf”—upload to “Acme Opp,” share 
with “Sales Team”—deal docs ready. 

• Setting Up Content Libraries  

o Summary: Organizing files—like “Marketing Collateral”—into secure, 
structured libraries. 

o Details:  

▪ This is your content warehouse—like a filing room with locks. Libraries 
group files (e.g., “Sales Guides”) and set permissions (e.g., “Managers 
edit”). Advanced Admins build them—like organizing 5,000 docs for 
10 teams. 

▪ How You Set It Up: Setup > Content > Libraries:  

▪ Create: “New Library”:  

▪ Details:  

▪ Name: Like “Sales Resources.” 

▪ Description: Like “Sales docs and guides.” 

▪ Save: Live for files. 

▪ Add Files: Libraries > [Library] > “Add Files”:  

▪ Details: Upload—like “Brochure.pdf.” 

▪ Tags: Like “Q1, Sales”—for search. 

▪ Permissions: “Manage Library”:  



▪ Details:  

▪ Roles: Like “Author” (add/edit), “Viewer” (see). 

▪ Assign: Users, Groups—like “Sales Team.” 

▪ Why It’s Great: Tidy—like “All sales stuff here.” Secure—like “No 
support access.” Scales—like “1K docs, 500 users.” 

▪ What’s Tricky: Perms overlap—profile vs. library. Tags need use—else 
search flops. Test—users might miss libs. 

▪ Real-Life Example: “Marketing Library”—upload “Flyer.pdf,” tag 
“Campaign,” Viewer “Marketing Team”—collateral sorted. 

• Using Content Delivery  

o Summary: Sharing files—like “Contract.pdf”—externally with security and 
tracking. 

o Details:  

▪ This is your secure dropbox—like emailing a locked file. Content 
Delivery sends files outside Salesforce (e.g., to clients) with options 
(e.g., “Expires in 7 days”). Advanced Admins use it—like distributing 
1,000 contracts safely. 

▪ How You Set It Up: Libraries > [File] > “Create Content Delivery”:  

▪ Details:  

▪ File: Like “Price List.pdf.” 

▪ Options:  

▪ Expiration: Like “03/18/2025.” 

▪ Password: Optional—like “abc123.” 

▪ Download: Allow/prevent. 

▪ Save: Link generated—like 
“salesforce.com/content/xyz.” 

▪ Share: Email link—like to “client@acme.com.” 

▪ Track: Libraries > “Content Deliveries”:  
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▪ Details: Views—like “Opened 03/10/2025.” 

▪ Why It’s Great: Safe—like “Clients see, can’t keep.” Tracks—like 
“They opened it!” Scales—like “1K links, no leaks.” 

▪ What’s Tricky: Setup—needs Library enabled. Links expire—plan 
timing. Test—clients might miss password. 

▪ Real-Life Example: “Proposal.pdf”—deliver to “jane@acme.com,” 
expires 03/15, password “deal2025”—secure pitch sent. 

• Controlling Access and Versions  

o Summary: Setting permissions—like “Sales edits, Support views”—and 
managing file versions for control. 

o Details:  

▪ This is your content guard—like a lock and logbook. You set who sees 
or edits files and track updates (e.g., “v1 to v2”). Advanced Admins 
lock it down—like ensuring 500 users access 10K files right. 

▪ How You Set It Up:  

▪ File Sharing: Files > [File] > “Share”:  

▪ Details:  

▪ Internal: Like “Sales Team” (View/Edit). 

▪ External: “Public Link” (View only). 

▪ Org-Wide: Setup > Security > Files Sharing 
Settings—like “Private on Records.” 

▪ Why It’s Cool: Granular—like “Reps see, Managers 
edit.” 

▪ Library Permissions: Libraries > [Library] > “Manage”:  

▪ Details: “Sales Team = Viewer,” “Managers = Author.” 

▪ Versions: Files > [File] > “Upload New Version”:  

▪ Details: Like “Proposal v2”—keeps “v1” in history. 

▪ Why It’s Great: Secure—like “No leaks!” Tracks—like “v3 fixed typo.” 
Scales—like “1K files, tight perms.” 
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▪ What’s Tricky: Sharing stacks—Library vs. File vs. Org-Wide. Versions 
pile—clean old ones. Test—perms might hide files. 

▪ Real-Life Example: “Guide.pdf”—“Sales = Viewer,” “Trainers = Editor,” 
update to “v2”—team sees latest. 

 

Tables 

Table 1: Files vs. Libraries 

What’s Different Salesforce Files Content Libraries 

Scope Any record Organized groups 

Access File-level sharing Library permissions 

Example “Contract on Opp” “Sales Guides folder” 

Table 2: Content Delivery vs. Public Link 

What’s Different Content Delivery Public Link 

Security Expiration, password Basic, no expiry 

Tracking Views logged No tracking 

Use External clients Quick internal share 

Table 3: Permissions Levels 

Level What It Does Example 

Viewer See only “Rep sees Guide” 

Editor/Author Edit, add “Manager updates Guide” 

Manager Full control “Admin sets perms” 

 

Practical Scenarios 

1. Upload File:  

o Need: Add “Proposal.pdf” to Opportunity. 



o Solution: Opp #001 > Files > Upload “Proposal.pdf”—linked and ready. 

2. Create Library:  

o Need: Organize sales docs. 

o Solution: “Sales Library”—upload “Brochure.pdf,” Viewer “Sales Team”—
docs sorted. 

3. Share Externally:  

o Need: Send “Contract.pdf” to client. 

o Solution: Content Delivery—expires 03/15, password “deal123”—client gets 
secure link. 

4. Control Access:  

o Need: Sales sees, Marketing edits. 

o Solution: “Marketing Library”—“Sales = Viewer,” “Marketing = Author”—roles 
locked. 

5. Update Version:  

o Need: Revise “Guide.pdf.” 

o Solution: Upload “v2”—“v1” saved, team sees latest. 

 

Study Tips 

• Hands-On: Free org (developer.salesforce.com)—upload a file, build a library, 
deliver content. 

• Start Simple: Trailhead’s “Content Management” module—free, with videos and 
tasks. 

• Focus: Master Files (upload/share), Libraries (organize), Delivery (external), 
Access/Versions (control). 

• Practice: “Set up a library?” or “Share a file securely?”—exam drills. 

• Beginner Boost: Watch “Salesforce Files Basics” on YouTube; try one task daily—
like file, then library. 



• Time: Spend 7%—3.5 hours of 50—split: 1 on Files, 1 on Libraries, 0.75 on Delivery, 
0.75 on Access/Versions. 

 


